
Illustrator Quick Tip Sheet...						      jennifer Medina

All palettes can be found under the Window menu

All (most) palettes have flyout menus located in the upper right corner of the palette, in the form of a circle with a triangle in it.

All palettes can be moved, broken apart from their groups, collapsed/minimized and closed.

The CONTROL Palette exists by default across the upper part of the screen, under the menus, and contains many of the commonly 
used  palette features (like stroke and character, so you don’t have to hunt around for the palette on your screen)

short cuts
1.CTRL Z   to Undo -- you can undo probably over 100 actions  - also found in EDIT MENU
2. CTRL C  to copy an object
3. CTRL V  to paste an object
4. CTRL G to group several objects  (must select them first)
5. CTRL R  to see the Rulers, which can be found under the VIEW MENU

zoom in and out short cuts

1.CTRL +  to zoom in
2. CTRL -   to zoom out
3. CTRL 0 (as in the number zero) to see the entire page
all of this can be done through the VIEW MENU 

Saving files:
1. Save working files (files that you can go back and edit) as .AI files

2. Save files that are finished artwork that will be placed as graphic that is Hi- Resolution (will go to press) as an EPS or TIF
(for EPS,  choose FILE, SAVE AS, and from the pull down list, choose Illustrator EPS, say yes to the dialogue box)
(for Tif,  choose EXPORT, and from the pull down list, choose Illustrator TIF, make sure it is 300 dpi at least, and choose whether it 
is for Mac or PC in the dialogue box)

3. Save files that are finished artwork for the web 2 ways: 
EXPORT, choose JPG if there are raster images in the file (photographs), choose what quality, high, medium, low, choosse resolu-
tion, then ok
OR SAVE FOR WEB will give choices for GIF (usually for vector art, containing NO photos), PNG, or JPG, can be viewed 2 or 4 
up, and the artwork is viewed in a preview box where it can be sliced if needed.

creating a pdf for press:
FILE, SAVE AS,  choose ADOBE PDF, 
from the dialogue box, choose 
• SMALLEST SIZE if the pdf will only be viewed on screen, and is not going to be professionally printed.
• HIGH QUALITY if the recipient is going to print from their own desktop printer
• PRESS QUALITY if sending to a print company and you don’t expect them to have to have access to ‘fix’ colors or any other 
aspect of the file like trapping - all responsibility falls on you 
• PDFX-1a:2001 (this would be my choice) if sending to a print company, it’s the older of the PDFX versions, but will work with 
every printer regardless of his equipment, and it gives the printer greater flexibility in prepping the file/trapping/color management. 
This takes the pressure off of you and puts the responsibility of setting up for pre-press on the printer.

for more, edge of your seat informatoin on PDF format explanations, go to http://pdf-x.com/

Linked files:
If you placed a file and it is linked, but you would like to embed it after the fact (make it a part of the file, self-contained), use the 
fly out menu in the Links Palette and choose EMBED IMAGE. This will increase the Illustrator file size. Rembember if you elect to 
link it, you’ll have to include the original along with the Illustrator file when submitting to press.



PALETTES-- keep only the ones open you need!

SWATCHES PALETTE
There are several icons at the bottom of the palette: 

• Show All Swatches (3 overlapping small quares)
• Show Color Swatches
• Show Gradient Swatches
• Create a new swatch (page with the corner turned up)
• Delete a swatch (trash can)

3 overlapping small quares that means all of the default colors, patterns, and gradients will be shown if selected. Each other icon 
will show each individual type of swatch

Create a new color 
1. Click on the New swatch (page with the corner turned up) icon
2. Double click on the new swatch created and modify the color sliders to get the color desired, and name it

Delete a Swatch
1. Click and drag to the trash

Open a swatch library (like a Pantone Color)
1. Click open the flyout menu in the upper right corner of the Swatches palette box
2. Scroll until you find the desired library
3. The new palette will open up as it’s own palette

GRADIENTS:

Creating a new gradient:  
1. Open the gradient palette (Window-Gradient)
2. Select a color stop
3. Click and drag a color from the Swatches palette over the top of the color stop selected

Adding extra color stops:
1. In the gradient palette, Click directly below the color spectrum anywhere to add a slider (color stop)

Deleting a gradient color stop/slider:
1. Simply click and directly down, off of the gradient palette and it will disappear.

Saving a gradient to the Swatches palette:
• In the Gradient Palette, click and drag the thumbnail of the gradient right into the Swatches palette. Dble click on it and name it.

APPEARANCE PALETTE:

A great way to manage the current object that is selected. It lists all of the different attributes of the object. Change the fill color, the 
stroke color by clicking on one or the other; if there is an effect applied, like a drop shadow or glow, double click on the effect listed 
to adjust settings. These attributes can also be deleted by throwing them in the trash can located at the bottom of the palette.

Layers PALETTE:

The best way to manage the objects in your Illustrator document. Many times your document will get complex by either a drawing 
that has many elements to it, or an ad that also has a lot of components, like placed images, text boxes, etc. Each element of your 
document can be placed on different layers. This makes it much easier to select different parts of the drawing or ad. By clicking in 
the space to the very right side of the Layers palette, you can select everything that is on that particluar layer (even if it is underneath 
another object).



Layers can be: 
• Created
• Viewed or hidden 
• Locked so the objects on the layer can’t be moved
• MOVED: Change the stacking order
• Given a specific name
• Deleted

• To Create a New Layer: Click the icon that looks like a page with the corner turned up at the bottom of the palette
• VIEW OR HIDE A LAYER:  Click the space fartherst to the left in the palette, the EYE icon 
• LOCK A LAYER: Click the space to the right of the EYE icon to lock the images on that particular layer; should see a lock icon
• NAME:  Double click on a layer to rename it
• MOVE: Click on a layer to highlight it blue, holding down the mouse click and drag up or downward to change stacking order 
DO NOT CLICK THE LITTLE CIRCLE. What the circle does is applies every attribute it posesses (effects like drop shadows and 
glows) to the entire layer of images
• DELETE: Drag to the trash can at bottom of palette

transform palette:
Allows to move an object accurately according to the reference point, using x and y coordinates.
Also allows to adjust the width and height of a selected object, rotate it or sheer (slant) it.

transparency palette:
Adjust the opacity of an object by changing the percentage

graphic styles, symbols and brush palette:
• GRAPHIC STYLES: Preset styles of fills and strokes that can be applied by selecting the object, then choosing a style from the 
Graphic styles palette. There are also a libraries that can be opened at the bottom of the WINDOWS MENU for more graphic styles 
choices.  Add a new graphic style of your own by creating an object with a specific fill and stroke, then just drag it right into the 
palette, double click on it to name it. Break the link in the bottom row of icons to change colors/effects.

• SYMBOLS STYLES: Preset art/icons that can be applied by clicking and dragging them from the Symbols palette onto the page. 
There are also a libraries that can be opened at the bottom of the WINDOWS MENU for more symbols styles choices. Add a new 
symbol of your own by creating an object, then just drag it right into the Symbols palette, double click on it to name it. Break the 
link in the bottom row of icons to change colors/effects.

• BRUSH STYLES: Preset strokes or artsy strokes that can be applied by selecting the objects stroke (make sure the stroke is se-
lected, not the fill) and choosing a brush preset from the Bruhes palette. There are also more strokes libraries that can be opened at 
the bottom of the WINDOWS MENU

pathfinder palette:
Use the Pathfinder palette to divide, combine, and break apart overlapping objects

character/paragraph palette:
Can be found under the Window menu, under TYPE near the bottom of the list

SELECTNG AN OBJECT:
In the Toolbox, use the SELECTION TOOL - which is the black arrow, to select an object

SELECTING A PATH, OR ANCHOR POINTS -- 
use the DIRECT SELECTION TOOL which is the white arrow to move directioinal handles, individual anchor points or  paths. 
Look for a little square to appear next to the arrow to know that the anchor/path/handle is directly underneath the arrow and can be 
selected.

Selecting more than one object--- use the SELECTION TOOL - which is the black arrow, hold down the SHIFT KEY, and select the 
other desired object



SELECTING WITHIN A GROUP OF OBJECTS
use the white arrow with the plus sign next to it (lives in the DIRECT SELECTION TOOLS’ HOME, which is the white 
arrow

pen tool:
This is a drawing tool, one of the main tools of Illustrator. use this tool to to draw line segments called paths, composed 
of anchor points and directional handles (to change direction of a curve). You must close a path to add a fill, gradient, or 
pattern, otherwise it will look flat on the part that isn’t closed. 

To manipulate a curve using the directional handles, use the DIRECT SELECTION TOOL (white arrow tool from the 
toolbox). Be patient and make sure you’re directly hovering over the handles end before trying to move it. 

DELETE ANCHOR POINTS: using the pen tool, hover over an anchor point and a minus sign should appear. click to 
delete
ADD ANCHOR POINTS: using the pen tool, hover over any part of the line segment until you see a plus sign (+) and 
click on the line to add an anchor point. 
CHANGE DIRECTION OF A CURVE: inside the Pen tool home, choose the upside down V, or Convert anchor tool. 
Place it over the the anchor point on a segment, click and drag to manuever the handle to a new direction. This also 
works if you’re in the middle of using the Pen tool, if you hold down the ALT KEY, click on the anchor and drag.

type tool:
This tool applies type. 2 ways to use it:

POINT AND CLICK: select the type tool, click anywhere on the page, type. The only thing is it won’t stop at the end of 
the page, you have to manually return

CLICK AND DRAG: using the type tool, click and drag a boundary box which acts as a container for the type. the 
boundary box can be adjusted/resized by moving/dragging the corner or middle squares using the Move tool.

APPLYING COLOR: make sure you know which is being applied, the fill or the stroke - thru the APPEARANCE pal-
ette, or the bottom of the toolbox.

CHOOSING TYPE/POINT SIZE: highlight the text, utilize the Control palette at the top of the screen, under the menus

Remember, you can apply effects to the type without turning them into outlines!

Outlines means that your turning the type into art, made up of lines and anchor points. In order to make sure the 
view will be able to see the original type intended, you may want to do this especially if you ‘ve used funky fonts that no 
one else has, by:

1.select the type
2. Go under the TYPE menu, choose Create Outlines --- now it’s art. fyi, once you save and close, you can’t go back and 
re-typeset the outined fonts,*** 

*** AS a back up/precautionary method, always save a copy of the type on another layer (and hide it) or off to the side 
of the document before creating outlines. you never know if the client might want to change a word or two ‘after the 
fact’

TYPE ON A PATH: this is a separate Type tool, you must draw a path first, then click on it with the Type on a Path tool, 
the line will disappear but whatever you type will follow the paths direction.. Adjust the baseline through the TYPE 
MENU, Type on a path, Type on a path options, then choose an Align baseline from the drop down menu.



draw a shape (rectangle,ellipse, etc):
This is a drawing tool, click and drag Hold shift key to keep in proportion or click once on the page to enter a numberical 
value. 

Scaling/.resizing:
Utilize the bounding box (make sure turned on under the View Menu)-- use the shift key to keep in proportion. Also, 
can resize through the Transform palette and by also looking at the Control Palette at the top of the screen (Width and 
Height).

change a fill or stroke:
Through the Appearance palette, choose the flyout menu, and choose ADD NEW FILL or ADD NEW STROKE. Make 
sure your object or type was selected prior to doing this. Choose a new color through the Swatches palette. 

Add Effects:
Like drop shadows, glows, to your type or an object. Select the object, choose an effect under the EFFECTS menu, 
where it says ILLUSTRATOR EFFECTS.  These will be editable: by looking in the Appearance palette you can double 
click on the effect to adjust the glow, drop shadow, etc. FILTERS have the same choices as Effects, but they are perma-
nent changes and cannot be “tweaked”.

Live trace:
A command found in the Control palette at the top of the screen, used to convert raster images into detailed vector 
graphics.  When you trace the artwork using LIVE trace, a tracing object is created. This is the newly created vector 
drawing. How to do it? 
1. Open the raster image
2. Select the image
3. Trace the image in the Control Palette, click Live Trace

Adjust presets to get a better tracing by going to the Control palette, choose the Tracing options dialogue (little icon next 
to the presets  pull down)--- higher Threshold gives more detail.

In order to edit the traced object, must EXPAND using the EXPAND button in the Control palette--- this will turn the 
tracing into editable paths, with anchors and directional handles, etc...


